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Introduction to the Display Interface

Before Getting Started

You can print or read this booklet from MicroImages’ web site.  The web site is
also your source for the newest tutorial booklets on other topics.  You can
download an installation guide, sample data, and the latest version of TNTmips.

http://www.microimages.com

The geospatial Display process is common to TNTmips, TNTedit, and TNTview.
This tutorial is an overview of the user interface for this process.  It  introduces
basic concepts, controls, and operating procedures that you can use while dis-
playing any type of geospatial data.  Techniques specific to particular data layer
and display types are introduced in the companion tutorial Displaying Geospatial
Data and covered in more detail in other tutorials on specific aspects of the
process.

Prerequisite Skills  This booklet assumes that you have read and completed the
exercises in the tutorial booklet Getting Started with TNTmips, TNTedit, and
TNTview.  That booklet introduces the general program interface, the TNTgis
Project File, spatial object types, and essential skills such as selecting data. These
concepts are not covered again here.  Please consult that booklet and other
TNTgis reference materials (installed or on MicroImages’ web site) for any review
you need.

Sample Data  The exercises presented in this booklet use sample data that is
distributed with the TNTgis software.  If you do not have access to a TNTgis
DVD, you can download the data from MicroImages’ web site.  In particular, this
booklet uses sample files in the PARKWAY and VIEW3D data folders.

More Documentation  This booklet is intended only as an introduction to dis-
playing geospatial data.  Consult the Technical Guides on MicroImages’ web site
for more information about the Display process.

TNTmips® License Levels  TNTmips (the Map and Image Processing System)
comes in three versions: the professional version of TNTmips (TNTmips Pro), the
low-cost TNTmips Basic version, and the TNTmips Free version.  All versions
run exactly the same code from the TNT products DVD and have nearly the same
features.  If you did not purchase the professional version (which requires a
software license key) or TNTmips Basic, then TNTmips operates in TNTmips
Free mode.

All the exercises can be completed in TNTmips Free using the sample geodata
provided.

Randall B. Smith, Ph.D., 21 April 2015
©MicroImages, Inc., 2005-2015
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Welcome to Using the Display Interface

In TNTmips:
Start TNTmips
choose Main / Display to
start the Display
process

In TNTedit:
Start TNTedit
press the
TNTview icon
button in the
toolbar

In TNTview:
Start TNTview

STEPSThe geospatial Display process is common to
TNTmips, TNTedit, and TNTview.  This core pro-
cess enables you to display all types of map, image,
and terrain data and provides many tools that en-
able you to explore the characteristics and database
attributes of your geodata.

You can display spatial objects stored in
MicroImages Project Files or in many other file for-
mats.  In the professional TNTgis software you can
also display web layers such as Bing Maps and
MapQuest maps and images, KML files, Web Map
Server and ArcIMS layers, and custom web tilesets
hosted by MicroImages or your own website.

The Display interface allows you to work with spa-
tial data georeferenced to different spatial reference
systems.  You can overlay multiple geodata layers,
and any layers with different georeferencing are au-
tomatically reprojected to register correctly with the
target reference system.

This tutorial introduces you to basic concepts, con-
trols, and operating procedures that you can use to
display and explore your geospatial data.  We focus
here on the general tools and controls that are appli-
cable to most types of data layers, such as how to
zoom and pan the View window, how to view and
explore the database information associated with
geodata layers, and how to make measurements and
add annotations to your data.  We also briefly intro-
duce some of the more complex display options such
as layouts and 3D perspective views, which are cov-
ered in more detail in other tutorials.

Once you are comfortable with the Display inter-
face, we recommend that you continue with the
Displaying Geospatial Data tutorial, where you will
learn how to display different types of geospatial
data layers and how to use more advanced display
tools and techniques.

The basics of the Display
process interface are
introduced on pages 4-5.
Basic operations such as
zooming and panning the
View as well as other
handy View sidebar tools
are covered on pages 6-11.
Pages 12-17 introduce
techniques for accessing
the attribute information
associated with the
elements in your spatial
objects.  Pages 18-22 cover
techniques for making
measurements from your
geospatial views and how
to add and save
annotations.  Display option
settings and procedures for
taking snapshots of the
View are introduced on
pages 23-25, and the
tutorial concludes by
introducing layouts and 3D
groups on pages 26-27.



page 4

Introduction to the Display Interface

STEPS
press the Add
Objects icon
button in the Display
Manager window
in the Select objects to
display window,
navigate into the folder
containing your TNTgis
Sample Data
navigate into the PARKWAY

folder, then into the
PARKWAY Project File
in the Browse list, left-
click on the icons for the
ORTHO, STREETS, and
zoning OBJECTS (in that
order) to select them
press the OK button on
the Select objects
window

Display Manager and View

The sidebar
in the View
window can
show layer
legends, a
locator, and
other viewing
aids.

The view canvas in the
View window displays
the spatial data layers.

toolbars

The main elements of the Display interface are the
Display Manager and the View window.  The Dis-
play Manager provides menus and a toolbar with
icon buttons for adding spatial layers and shows a
list of the layers that have been added to the dis-
play.  These layer entries also provide controls for
setting display options for the layer, hiding or show-
ing the layer, examining attribute tables, and other
functions.

The View window has a view canvas in which the
layers are displayed and menus and toolbar icons
that allow you to manipulate the view area and acti-
vate tools for exploring the data being displayed.
An optional sidebar can display layer legends, a lo-
cator pane, a magnifier, and other viewing aids.  A
small triangular icon button opens and closes the

sidebar.

This icon button closes and opens the sidebar.

The last layer
added is the
default active
layer (name in
bold font).
Click on any
layer entry to
make it the
active layer.
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STEPS
left-click on the
Layer Controls
icon button for the ORTHO

layer in the Display
Manager
note the entry in the
Georeference field in
the Raster Layer
Controls window, then
press the OK button.
left-click on the
Show / Hide icon
button for any of the
layers to hide it; left-
click again to show it.

In the previous exercise you selected three spatial
objects: one color-composite image (raster object)
and two vector objects.  Each of these objects was
added as a separate layer entry to the list in the
Display Manager. They were also added to the View
canvas.  Layers are named by default with the name
of the contained object.

The icon shown to the left of each layer name in the
Display Manager list indicates the type of object in
the layer.  If you place the cursor over one of these
icons you will see a “Layer  Controls...” ToolTip.
Each of these icons also serves as a button that
opens a Layer Controls window specific to the type
of layer.  This window lets you
adjust the display parameters for
each layer; these settings are au-
tomatically saved with the layer’s
object.  Layer-specific display
settings are covered in the Dis-
playing Geospatial Data tutorial.

The “check mark” icon button to
the left of each layer icon is the
Show/Hide button.  Left-click on
the button to hide the layer (check
mark not shown) and click again
to show the layer (check mark shown).

The layers are listed and displayed in the same order
in which you selected their objects: the first object
you selected (ORTHO) is the bottom layer and the last
object you selected (ZONING) is the top layer.  You
can move a layer up or down in the list by dragging
its entry.  (You can also right-click on the layer name
to open a right mouse-button menu and choosing
one of the layer movement options: Raise, Lower, To
Bottom, or To Top; some options may not be active
due to the current position of the layer).

Display Manager Layer List

left-click on the layer
name “streets” in the
Display Manager and
drag the entry to the top
of the list

The Georeference field
shows the object’s
coordinate reference
system.
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Zooming and Panning the View
STEPS

press the Zoom In
icon button in the
View window toolbar
place the cursor over
the View and press the

key to zoom in at
the cursor location

View Position Tool Zoom Box Tool

Full

Previous
Zoom

In
Zoom
Out

Zoom to
Active Layer

Zoom to
Maximum Detail

with the View
Position tool
active, left-click and
drag to pan the View
contents
press the key to
scroll the view upward
if you have a mouse
with a scroll wheel, roll
the wheel to zoom in
and out
press the Full icon
button to zoom out
to the full extents of the
layers
press the
Zoom Box
tool icon button
left-click and drag
open a box in the
View to zoom in
to the boxed area

Keyboard Shortcuts

zoom in (at cursor)

zoom out (at cursor)

zoom to full view

zoom to 1X
(maximum image
detail)

zoom to 2X

To see more shortcuts open
the HotKeys menu in the
View window.

scroll 90% in arrow
direction

The icon buttons on the left side of the View win-
dow toolbar zoom the view canvas.  The Zoom In
and Zoom Out buttons change the view scale by a
factor of two while keeping the same view center
location (except when near the edge of the data).
Keyboard shortcuts that zoom at the cursor posi-
tion are also provided.  The Previous button returns
to the zoom and position just prior to the previous
redraw.  The Full icon button zooms the canvas to
show the full extents of all layers.  Zoom to Active
Layer zooms to show the extents of the active layer
in the View; this is useful if layers with different ex-
tents are being displayed.  For displays with raster
layers, the Zoom to Maximum detail button zooms
so that one image cell occupies each screen pixel.

zoom box
The icon buttons on
the right end of the
toolbar activate tools
that let you directly
manipulate the view.
Use the default View
Position tool to drag
the view in any direc-
tion or use the arrow keys to pan left, right, up, and
down.  Use the Zoom Box tool to drag open an elas-
tic box; when you release the mouse button the
display zooms to the extents of the box.
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STEPS
press the Locator
icon button at the
bottom of the View
sidebar (skip this step if
the Locator is already
shown)
if the View is at full
extents, zoom in using
any of the zoom
methods
drag the box in the
Locator panel to pan the
view
drag an edge or corner
of the box to resize it
and zoom the View

Sidebar Locator and Zoom Panels

in the
Zoom
sidebar
panel,
press the arrow icon
button to the right of the
numeric scale value and
choose 1:5000 from the
menu

press the Zoom
icon button at the
bottom of the View
sidebar (skip this step if
the sidebar zoom
controls are already
shown)

Locator On/Off Zoom On/Off

Sidebar
controls

Locator

Zoom Current
View
scale

Icon buttons at the bottom of the View window
sidebar allow you to show or hide sets of additional
controls in the sidebar.  In this exercise we use two
of these, the sidebar Locator and Zoom panels.

The Locator panel shows a reduced-size view of the
full extents of all of the layers being displayed.  An
elastic box in the Locator indicates the portion of
the display that is currently visible in the View.  You
can drag the box in the Locator in any direction to
pan the view.  You can also resize the box by drag-
ging an edge or corner to zoom the View.  Making
the box bigger zooms out; making the box smaller
zooms in.  You can make the size of the Locator panel

itself larger by dragging the top of the Locator up-
ward and/or by dragging the edge of the sidebar
into the View canvas.  You can open a separate Lo-
cator window by choosing Display / Open Locator
View in the Display Manager.

The sidebar Zoom panel has a pair of menus.
When the menu on the left is set to View Scale,
you can use the menu on the right to choose
a new map scale at which to display the layers.  You
can also enter a map scale  or scale factor (the num-
ber after “1:”) in the field to the left of the menu
button.  If you choose the View Width or View Height
option from the menu on the left, you can enter a
ground distance in the zoom field using units se-
lected from the menu on the right.
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Magnifier and Layer Transparency
STEPS

turn off the Locator and
Zoom panels in the
View sidebar
turn on the
Magnifier in the
sidebar
move the cursor to
different locations in the
View
use the + and - icon
buttons in the Magnifier
to change the
magnification level
turn off the Magnifier
turn on the
Transparency
panel in the
sidebar
in the Display Manager,
left-click on the ZONING

layer entry to make it the
active layer
move the Transparency
slider to see the effect
on the View
return the Transparency
slider to 0
turn off the
Transparency panel

The Magnifier panel provides a zoomed rendering
of the portion of the View around the current posi-
tion of the screen cursor, allowing you to examine
details of local areas of the View.  The Magnifier
updates continuously as you move the cursor over
the View.  The current magnification level is shown
in the upper left corner of the Magnifier pane.  The
minimum magnification is 2X, and you can vary the
magnification using the small icon buttons above
and below the magnification label.

The Transparency panel lets you vary the transpar-
ency of the active layer in the View.  The panel has a
slider and an accompanying numeric field that shows
the current transparency value (between 0 and 100%).
You can either move the slider or type a desired trans-
parency value into the numeric field.

Transparency applied using the sidebar panel is in
addition to any transparency set for the layer in its
Layer Controls or in the styles of individual elements.
For example, polygon styles in the ZONING object set
a transparency value of 60% for each fill color, while
the lines corresponding to polygon borders are
opaque.  The sidebar Transparency setting increases
the polygon fill transparency and applies transpar-
ency to the orginally-opaque lines.

Zoning layer with additional 50% transparency applied.

The Magnifier shows a
magnified view of the
area around the cursor.
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Note the entry at the top of the layer list in the Dis-
play Manager that is named Display Group 1.  Display
Group 1 was automatically created to contain the
three layers we added in the first exercise (note that
the layer entries in the list are indented relative to
the group entry).  The View window opened to dis-
play this group, so it is titled Display Group 1 - View
1 (you can open additional views of a particular
group by choosing Display / Open View).

In the Display process a group is a set of one or
more layers that are displayed together.  Any
spatial view has at least one group.  A group can
contain spatial data layers and map grids, or (in
map layouts) individual layout elements such
as legends, scale bars, and text.

In a group with georeferenced layers, all layers are
drawn to match a particular coordinate reference
system (CRS) and are positioned relative to each
other using that CRS.  The spatial objects we have
been viewing are all georeferenced to the same
CRS, “NAD 83 / Lancaster County (ftUS)”, which
is therefore the group CRS.  You can see the
name of the CRS for a layer in its Layer Controls
window (see page 5) or in the Layer Info win-
dow illustrated here.

The layers in a group do not have to reference
the same coordinate reference system.  Any lay-
ers georeferenced to different coordinate reference
systems are automatically reprojected in the View to
match the group CRS.  In a later exercise we will see
how the group CRS can be set in such cases.

STEPS
right-click on the STREETS

layer entry in the
Display Manager
choose Layer Info from
the right mouse-button
menu
note the CRS name in
the Layer Info window

Display Group and Georeference

close the Layer Info
window
repeat for the ZONING and
ORTHO layers

The name of a coordinate reference system consists of: [geodetic datum name] /
[coordinate system name].  The objects in this exercise are georeferenced to the
planar coordinate system defined for Lancaster County, Nebraska, which uses a
Transverse Mercator map projection with locations specified in feet.  A geodetic
datum specifies a particular mathematical model of the shape of the Earth.  The
Parkway objects are referenced to the North American Datum 1983 (NAD83).
For more background see the tutorials entitled Coordinate Reference Systems
and Introduction to Map Projections.



page 10

Introduction to the Display Interface

Position Reports and the Places Panel
STEPS

move the cursor over
the View canvas and
note the changing
values in the Position
Report fields at the
bottom of the View
window
turn on the
Places icon
button at the bottom of
the sidebar
in the Places panel,
enter value 165600 in
the East field and
205300 in the North field
press the Center
icon button in the
Places panel

Two Position Report fields are included at the bot-
tom of the View window.  These fields show
coordinates for the current position of the cursor in
the View.  Position Report 1 (on the left) defaults to
the current group coordinate reference system.
(Place the cursor over the field to see a ToolTip with
the name of the CRS as shown in the illustration
above.)  Position Report 2 defaults to geographic
(longitude/latitude) coordinates.  The Options menu
on the View window provides an entry for each po-
sition report that allows you to change the CRS for
the report and/or the format to use for geographic
coordinates (see page 23).

Position Report 1 Position Report 2

Places Pane

Places
On/Off

Change
View
Position
(mode)

Center
(action)

The Places sidebar panel lets you change the posi-
tion of the View in several ways.  Three icon buttons
at the top of the Places panel let you choose a mode
for repositioning.  The default Change View Posi-
tion mode provides fields in which you can enter
new coordinates for the center of the View.  After
entering coordinates, press the Center action but-
ton to recenter the View.  You can change the CRS to
use for the entered coordinates by pressing the CRS
pushbutton above the coordinate fields.

turn off the Places panel
in the sidebar

For more uses of the Places
panel, see the Set View
Positions with Places Panel
and Save Locations with
Places Panel Technical
Guides.

view recentered
at this location
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Sidebar Legend
The STREETS and ZONING vector objects each have a
number of display styles that are keyed to the val-
ues of attributes in associated database tables.
Samples of these styles are listed in the sidebar Leg-
end.  Like the Display Manager, the Legend has an
entry for each layer in the display.  The STREETS leg-
end shows line styles for different types of streets,
and the ZONING legend shows polygon fill colors
assigned to different zoning districts.  You can col-
lapse or expand each layer entry to hide or show its
legend.  You can also hide or show the entire legend
as needed using the Legend icon button at the bot-
tom of the sidebar.

Turning a layer’s Show / Hide checkbox in the Leg-
end on or off only affects layer visibility in the View
canvas; it does not affect the Locator (unlike the
checkbox in the Display Manager).  You can right-
click on the Show / Hide checkbox in either the
Legend or the Display Manager to show a menu
with visibility toggle choices for the Locator and
each open View.

press this icon button
again (now looks like

) to expand the
STREETS legend
turn on the sidebar
Locator panel
turn the Show /
Hide checkbox for
the STREETS layer entry
in the Legend off and
then on; note that only
the main View is
affected

STEPS

press the   icon
button for the STREETS

layer in the sidebar
Legend to collapse the
layer’s legend

Right mouse-button
menu for the Show /
Hide checkbox

Legend On/Off

STREETS layer still
shown in Locator while
hidden in the main View
canvas after using the
Show / Hide checkbox
in the Legend.
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The layer entries in the Display Manager list are
also provided with expand/collapse controls (  ).
Expanding the layer entry for a vector layer reveals a
list entry for each type of vector element that is in-
cluded in the object and chosen for display.  In the
case of the STREETS layer in this exercise, the expanded
layer entry shows a listing for line elements, which
also shows the number of lines in the object.

Each vector element entry in the Display Manager
list can also be expanded to show an entry for each
database table (if any) that is associated with these
elements in the object.   In the STREETS layer there are
two tables, streets and StreetType.  These tables have
been set to appear in tabular view, like a spread-
sheet, in which each record occupies a row and each
column is a data field in the table.

The streets table has one record for each line ele-
ment in the vector object, and each of these records
is attached to its corresponding line and shows at-
tributes specific to that line.  The StreetType table,
on the other hand, has one record for each type of
street.  Its records are not directly attached to line
elements, but instead are related to records in the
streets table (and thus indirectly related to the line
elements) by common values in the TYPE field in
each table.

STEPS
zoom the View
out to full extents

View Database Tables

in the expanded entry
for STREETS, press the
expand icon button ( )
for lines

in the Display Manager,
press the expand icon
button ( ) for the
STREETS layer

turn on the Show / Hide
Table checkbox for the
streets and StreetType
tables as illustrated
below
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DataTips
STEPS

place the mouse cursor
over one of the street
lines in the View
note the DataTip that
appears
in the Display
Manager, press
the Layer Controls icon
button for the STREETS

layer
click on the Lines tab in
the Vector Layer
Controls window
note the selection in the
Show menu in the
DataTip section
close the Vector Layer
Controls window

You can show attribute information for geodata lay-
ers interactively in the View using DataTips.  You
choose a field in a table to provide text for a DataTip
box that appears temporarily in the View when you
hold the mouse cursor over an element in the layer.
Controls for choosing the DataTip field are in the
Layer Controls window for the layer.  The STREETS

and ZONING vector objects in the View each have a
designated DataTip field (for lines and polygons,
respectively);  when the cursor is on both a street
line and a zoning polygon, information about both
appears in the DataTip.  The STREETS line DataTip
provides the street name, type of street, and the
speed limit.  The database field referenced by the
STREETS DataTip is a Computed Text field that con-

catenates information from several fields in the
streets table.    The DataTip for the ZONING polygons
also references a Com-
puted Text Field.  You can
learn about Computed Text
fields in the Managing
Geoattributes tutorial.

DataTip with
information about the
street line and the
zoning district polygon
at the cursor location

The Layer Controls window for vector, CAD, and shape
objects provides controls for setting element DataTips.

The Select Attribute option in the Show
menu for DataTips opens the Select
Table/Field window so you can choose
a table and field to provide element-
specific text for DataTips.
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Mark Elements in the View
The Select Tool in the View window toolbar al-
lows you to mark (select) elements in the View
window.  Marked elements are shown in special
colors in the View.   Records that are attached or

related to the marked element(s) are also highlighted
in any open views of the layer’s database tables.
This allows you to examine all of the database at-
tributes associated with the marked element.

In order to mark a vector layer’s elements in the View,
marking must be enabled for that particular element
type.  A red arrow icon button next to the element
entry in the Display Manager controls this behavior
(see illustration above left).  Marking is initially dis-
abled by default for elements in a vector layer but is
enabled automatically when you open a database

table view for that element type (as it
was for the STREETS layer in our View).

Icon buttons in the View toolbar con-
trol element marking behavior.  The
Mark Exclusive mode marks one and
only one element at a time (a marked
element is unmarked automatically
when another one is marked).  The
Toggle Marked mode allows you
mark any number of individual ele-

ments by left-clicking on them.  Clicking on a marked
element unmarks it.

Marking not
enabled

Marking
enabled

STEPS
turn on the Select
tool in the View
window toolbar
left-click on one of the
lines in the STREETS

vector layer in the View
note the records
highlighted in the streets
and StreetType tables
press the Unmark
All icon button in
the View

Records attached or related to
the marked element are
highlighted in the table views.

Line element in the STREETS vector
layer marked in the View.

Mark Exclusive Toggle Marked

Element Marking Modes

Unmark All

Select
tool
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Using Attributes to Mark Elements
You can also invert the procedure from the last exer-
cise and use a selected record or records in a table to
mark the associated elements in the View.  The Mark
Elements and Exclusive buttons in the table window
both mark all elements that are associated with the
selected records.  The Exclusive button also unmarks
any previously marked elements, while the Mark El-
ements button merely adds the new elements to the
marked set.

STEPS
in the StreetType table,
left click on the gray box
to the left of the record
with “U.S. Highway” in
the DESCRIPTION field
note that a red
checkmark appears in
the box

press the Mark
Elements icon
button in the StreetType
table window toolbar
note that the line listing
for the STREETS layer in
the Display Manager
indicates 23 lines are
marked

in the streets table
window toolbar, press
the Show marked
element records
icon button

Active
element

Marked
elements

Mark Elements

Exclusive Unmark
Toggle
Elements

Show All Records

Show Marked Element Records
Show Active
Element Records

Switch to single
record view

In a set of marked elements, one element is always
designated as the active element, which is shown in
a different color (default magenta) than the remain-
ing marked elements (default red).  (The Colors
selection on the View window’s Options menu opens
a Select Colors window that lets you choose colors
for marked and active elements; see page 23).   Icon
buttons in tabular views of database tables let you
set whether to list all records, only marked element
records, or just the records for the active element.
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Single Record Database Table View
STEPS

in the streets table
window toolbar, press
the Switch to
single record
view icon button
in the View window
toolbar, press the
Next Marked icon
button several times

Next MarkedPrevious Marked

The View automatically zooms and recenters
on the active element when using the Next
Marked or Previous Marked icon buttons.

Next RecordPrevious Record

Switch to
tabular
view

An alternate way to view a database table is single
record view.  As the name implies, this mode of view-
ing a table shows only a single record at a time.  The
names of all of the fields are shown in the left-hand
Name column, and the values of the fields in the
current record are shown in the center Value col-
umn.  The Units column shows the units assigned
to any numeric fields and also shows the format for

date and date/time fields.  Single
record view is useful when a table
includes many fields, as all of the field
values for a particular record can be
seen at a glance.  Tabular view re-
quires scrolling the window
horizontally to see all of the values
for a record with many fields but al-
lows seeing multiple records at once
so that values can be compared.

When elements are marked in the View,
a single record table view by default
shows the record for the active ele-

ment.  You can use the
Next Marked and Previ-
ous Marked icon
buttons on the View to
step through the
marked element set; the
single record table view
updates automatically
to show the current ac-
tive element record.  You
can also use the Previ-
ous Record and Next
Record icon buttons on
the table window to
step through all of the
records in the table with-
out regard to marked or
active elements.



page 17

Introduction to the Display Interface

Mark Elements by Database Query
We chose the current set of marked elements by
manually selecting the record for U.S. Highways in
the STREETTYPE table.  A more flexible method for
identifying database records to mark elements is to
use a database query to specify records with a par-
ticular attribute or combination of attributes.  The
Query Builder provides a handy set of interactive
controls that let you construct a query expression.

The SPEEDLIM field in the streets table specifies
the legal speed limit (in miles per hour) for each street
line.  Our query in this exercise identifies street lines
with a speed limit equal to 40 miles per hour:

streets.SPEEDLIM == 40

We could apply this query to all elements, but by
choosing to apply this query only to the previously
marked elements, we refine our previous selection
of U.S. Highway segments to those with a speed
limit of 40 miles per hour.  You can learn more
about using database queries in the tutorial en-
titled Building and Using Queries and the
Interactive Query Builder Technical Guide.

STEPS
zoom out Full but
keep the marked
element set from the
previous exercise
in the View window
toolbar, press the
Mark by Query
icon button

press the arrow icon
button on the Choose
Type/Table menu at the
top of the Builder tabbed
panel
from this menu choose
the table streets

In the Mark streets (Lines)
by Query window:

Query expression constructed
with the Builder controls

operator

left side of expression

right side of expression

open the Choose Field
menu; scroll down in the
menu and choose field
SPEEDLIM
choose 40 from the
menu of values in the
middle of the window
press the Apply to
Marked pushbutton at
the bottom of the Builder
panel

U.S. Highway line segments with
speed limit = 40 miles per hour.
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Measurements from Marked Elements
Suppose that we want to know the aggregate length
of the street lines that we have marked in the View in
order to know how many 40 mph speed limit signs
are needed for that section.  We can find the total
lenth quickly using the GeoToolbox.  The
GeoToolbox provides a collection of drawing tools
that can be used for measurement and sketching.  It
also serves as the management center for regions,
which are temporary or saved objects that can be
used for measurement and element selection.  The
typical region is a set of one or more polygons that
outline an area of interest.  But a collection of lines
or points can also define a region for purposes of
measurement.

When elements are marked in the View, the active
element and the set of marked elements each define
a temporary region that can be selected on the Re-
gion tabbed panel in the GeoToolbox.  The Measure

panel shows the map extents and centroid posi-
tion for the selected region and for the layer as a
whole.  For line elements it also shows the total
length of the lines, and for marked polygons it
shows the total perimeter and area.

STEPS
press [Close] on the
Query Builder window
but keep the marked
element set from the
previous exercise
in the View window
toolbar, press the
GeoToolbox icon
button
in the GeoToolbox
window, click on the
Region tab
on the Region panel
click the expand
button for Display
Group 1 to show an
entry for each layer in
the View
expand the entry
for the STREETS layer
left-click on the Marked
Lines entry under
STREETS

note the changed
highlight color for the
marked lines (the color
may be different on your
installation from the one
illustrated)

left-click on the Measure
tab to see the length
measurement
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Measuring with GeoToolbox Tools
STEPS

press the Unmark
All icon button in
the View toolbar

select the
Rectangle Tool in
the GeoToolbox
left-click and drag in the
View to draw an elastic
box
drag on the interior of
the rectangle to
reposition it
drag an edge or corner
of the rectangle to
resize it
note the measurement
values in the
GeoToolbox Measure
panel
close the GeoToolbox
window when you have
completed this exercise

Rectangle Tool

select the Ruler
tool from the
GeoToolbox toolbar
left-click and drag to
draw an elastic line in
the View
left-click and drag on the
line to reposition it
left-click and drag an
endpoint to resize or
reorient the line
note the measurement
values in the
GeoToolbox Measure
panel

Ruler Tool

The GeoToolbox provides an extensive set of draw-
ing tools accessed from its toolbar.  You can draw
points, straight ruler lines, complex lines and poly-
gons, and various regular geometric shapes.  Drawn
elements can be used for measurements, saved as
region objects, and added to sketch layers.  For a
more complete survey of the GeoToolbox tools, re-
fer to the tutorial Sketching and Measuring.

The ruler tool lets you draw a simple two-point elas-
tic line in the View that you can resize, reorient, and
reposition as needed.  The screen cursor shape
changes as you interact with the ruler line. A point-
ing hand cursor appears when positioned over the
line interior, allowing you to left-click and drag to
reposition the line.  A cross-hair cursor appears when
positioned near either end of the line, allowing you
to drag the end to resize and reorient the line.  With
the Rectangle tool, a double arrow cursor appears
when over an edge or corner, allowing you to adjust
the size and shape of the rectangle.

Values on the Measure panel update as you adjust
the graphic in the
View.  You can
change the mea-
surement units
shown by choos-
ing Options /
Measure / Units
on the GeoToolbox
window.
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Annotate Tool

Text

Circle

RectanglePoint

Action / Settings

Line

Polygon

STEPS
turn on the Zoom
Box tool in the
View and zoom in on
the Nebraska State
Capitol building (near the
center left edge of the
ortho image)
turn on the
Annotate tool
turn on the
Rectangle tool in
the Annotate toolbar
draw a box outlining the
Capitol building and
grounds, then right-click

The Annotate tool allows you to quickly
add simple graphic and text annotations
over your other data layers in the View win-
dow. You can draw points, lines, polygons,
rectangles, circles, and text while setting
colors, line/border weights, and fonts.  If
you wish to reuse the annotations later,
you can save the annotation layer as a

CAD object in one of your Project Files.

When the Annotate tool is activated, icon buttons
are added to the right end of the View toolbar so you
can choose the drawing mode.  (You may have to
make the View window wider to see all of the icon
buttons.)  After drawing an element or placing text,
and making any needed adjustments, press the right
mouse-button to add the element to the annotation
layer.  One or more additional icon buttons also ap-
pear in the toolbar for each drawing mode so you
can choose options such as color, line or border
weight, and font.

The Annotate toolbar also includes an Action / Set-
tings button that opens a menu.  The Delete Last
Annotation option deletes the last element you added
to the current annotation layer.  The Clear Drawing
Tool option clears the current tool graphic.  Use the
Save to option to save the annotation layer as a
CAD object in a Project File and the Open option to
open an existing saved CAD object for modifica-
tion.  For more information see the Annotate Tool
Technical Guide.

turn on the Text
annotate tool
left-click in the View to
the left of the Capitol
box and type “State
Capitol”, then right-click

Note that a layer named
“Sketch” was added to the
Display Manager and View
legend for the annotations.
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Save Sketch and Group

STEPS

press the Action /
Settings icon
button in the Annotate
toolbar and choose
Save to from the menu

In the Save sketch (CAD)
object window:

navigate to the PARKWAY

folder
in the New File Name
field, enter “MyGroups”
press [Create File]
accept the text in the
New Object Name field
and press [OK]

in the Display
Manager, press
the Save Display icon
button

navigate to the PARKWAY

folder and into the
MYGROUPS Project File
you created
accept the text in the
New Object Name field
and press [OK]

In the Select object to save
group as window:

in the Display Manager,
right-click on the Display
Group 1 list entry
choose Close Group
from the right mouse-
button menu

Save the Sketch

Save the Group

Close the Group

NOTE: more extensive
drawing and sketching
capabilities are included in
the GeoToolbox, as
described in the Sketching
and Measuring tutorial.

Enter a name
for the new
Project File in
the PARKWAY

folder, then
press
[Create File].

When the new file is
created, the Save
dialog automatically
navigates into it.

Accept name the new object (or accept the
default name) and press the OK button to
complete saving the Sketch layer.

We can save our annotation layer as an object in a
Project File, then create a saved group that  includes
the original three data layers and the new annota-
tion layer.  A saved group can be reopened later,
which automatically loads all of the layers that were
included in the original group.  The display settings

for each layer are also saved with the group, so when
it is reopened each of its layers appear just as they
did when the group was saved, even if the display
settings for individual layers have been changed
after the group was saved.

NOTE: Since the new group references objects in
both the PARKWAY and MYGROUPS Project Files, these
files must be kept together (if moved) in order for
the group to maintain valid links to all of its layers.
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Change Group Coordinate Reference
STEPS

Open a Saved Group
press the Open
Display icon
button in the Display
Manager
in the Select Objects
window, navigate into
the PARKWAY folder in
your TNTgis sample data
sets
navigate into the GROUPS

Project File
select the group named
hydrology and press
[OK]

left-click on the
ELEV_CONTOUR layer entry
in the Display Manager
or View sidebar to make
it the active layer

Change the Group CRS

in the Projection controls
in the Group Settings
window, choose None
from the Auto-Match
menu
press the Set from
Active Layer pushbutton
press [OK] on the Group
Settings window

Although most of the layers in the hydrology group
that we open in this exercise are georeferenced to
the Lancaster County coordinate reference system
described earlier, the ELEV_CONTOUR layer is
georeferenced to NAD83 / Geographic.  The group
CRS by default is set to automatically match the first
layer in the group, which in this case means that the
group CRS is the Lancaster County CRS.

The Auto-Match menu in the Projection controls in
the Group Settings window allows you to auto-
match the group CRS to either the First Layer or the
First Image Layer.  You can turn off auto-matching
by choosing None from the menu, which activates
the other Projection controls.  You can set the group
CRS from the active layer, which in this exercise
reprojects all layers to NAD83 / Geographic.  You
can also press the Projection button to open a dia-
log window that allows you to choose from the

hundreds of coordinate refer-
ence system combinations
provided in the TNTgis prod-
ucts.  See the Coordinate
Reference Systems tutorial for in-
structions on choosing a CRS.

in the Display Manager
press the Settings
icon button for the
HYDROLOGY group
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View Window Options Menu
STEPS

open the Group
Settings window,
set the Auto-Match
menu to First Layer, and
press [OK]
open the Options menu
on the View window,
examine the options,
and choose the Colors
option
in the Select Colors
window, change the
color of the Main
Background if desired
and press [OK]
open the Options menu
again and move the
cursor over DataTips
and Position Report 1
entries to see their
submenus

Select background, marking,
and graphic tool colors

Choose whether to show either Position
Report, choose the spatial reference
system for the coordinates, and the format
for geographic coordinates if applicable.

Hide or
show the
View
sidebar

The Maximum option on the DataTips submenu
shows information at the cursor location for all
layers that have DataTips set.  Other options
include the Active or Top layer, or only visible
layers.

The Options menu on the View window lets you
make a number of changes to the layout and func-
tioning of the View window.  Among other options,
you can change the background colors of the main
View and the Locator as well as the colors used for
marking elements and for graphic tools shown in the
View.  You can choose to show or hide a scalebar in

the View.  The Position
Report options let you
set the spatial reference
system and geographic
coordinate format for the
Position Reports.  The
DataTip submenu lets
you set which layers in
the View contribute in-
formation to DataTips in
the View.
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Customize the View Toolbar and Menus
STEPS

choose Customize from
the Options menu in the
View
in the Customize Hidden
Features window,
expand the entries for
the View, Mark, and
Tools toolbars
close the Customize
window

View Toolbar Mark Toolbar Tool Toolbar

The View and Tools menus and the icon buttons on
the View toolbar let you perform actions in the View
and to activate graphic tools.  The View, Mark, and
Tools toolbars in the default installation provide a
selection of the most frequently-used actions and
tools.  You can choose which selections appear in
the View, Tools, and Options menus and which icon
buttons appear in the  toolbars using the Custom-
ize Hidden Features window, which you open from
the View window’s Options menu.

View Toolbar Options
Mark Toolbar Options Tools Toolbar Options

choose Options /
View Options from
the Display Manager
click on the View
tab in the Options
window and
examine the options
close the Options
window

The Options window opened from the Display Man-
ager (Options / View Options) allows you to set a

large number of display options.  The Layer panel
lets you choose the source of the default layer
name  shown in the Display Manager and sidebar
legend (object name, object description, or file and

object name).  The
View panel lets you
choose the tool that
is initially set as ac-
tive when the View
window opens, and
to choose the
sidebar location
(left or right of the
View canvas).



page 25

Introduction to the Display Interface

Quick Snapshots of View Contents
STEPS

choose Options /
Snapshot Settings from
the View window

The Quick Snapshot icon button in the View
window’s View toolbar allows you to save images of
the View contents that you can use for presenta-
tions or publications.  Snapshots are captured as a
composite of all of the layers currently visible in the
View at the resolution of the screen.  The snapshot
is saved as a 24-bit image in a file format and folder
location that you specify using the Quick Snapshot
Settings window, which you can open by choosing
Options / Snapshot Settings  in the View window.

You can save snapshots as RVC raster objects in
Project Files, or as (Geo)JP2, (Geo)TIFF, JPEG, or PNG.
format, with several compression options for most
formats.  Georeference information is automatically
saved with snapshots to GeoJP2, GeoTIFF, or RVC,
and you can choose to save supplementary
georeference files (Arc World, PRJ, and KML) when
saving to these or other external formats.

Use the Quick-Save Folder pushbutton in the Set-
tings window to choose a folder where snapshots
will be automatically saved.  Files are named using
the text you provide in the Quick-Save Prefix field
followed by a number that is automatically
incremented by 1 starting with the value in the Next
Index field.  You can change these settings at any
time to direct a new series of snapshots to a new
location on your hard drive.

Choose format Choose snapshot folder

Choose filename prefix Set the starting index number

For more information see
the Quick Snapshot of View
Contents and Quick
Snapshot for Google Earth
Technical Guides.

use the Format menu to
choose an image format
press the Quick-Save
Folder pushbutton to
choose a folder in
which to save the
snapshot files
enter a root name for
the snapshot files in the
Quick-Save Prefix field
Edit the Next Index field
if desired to set a
starting index number
for the auto-incremented
snapshot file names
press [OK]

In the Quick Snapshot
Settings window:

zoom in on an area of
interest
press the Quick
Snapshot icon
button

In the View window:

Note: the Quick Snapshot
Settings window opens
automatically when you
press the Quick Snapshot
icon button if you have not
yet specified snapshot
settings.
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Layouts
STEPS

in the Display Manager,
right-click on the
HYDROLOGY group entry
choose Close Group
from the right mouse-
button menu
press [No] in the
Question dialog
concerning changes to
the group
press the Open
Display icon
button
navigate out of the
GROUPS Project File,  into
the PARKWAY folder
navigate into the
LAYOUTS Project
File
choose object
HYDROLAYOUT and
press [OK]

Page layout
designed for print
media, with map
grid, scale bars,
and legend.

To create a new
layout,
press the
New icon
button and choose
Tiled Layout,
Display Layout, or
Page Layout

A layout is a more complex display that can include
multiple groups.  You can create and save several
different types of layouts.  Page layouts are intended
for printing; you choose a media size, place groups
on this virtual page, and have the option to add
scale bars, legends, and text annotations (see illus-
tration below).  Display layouts and tiled layouts are
intended for on-screen use.  In a display layout,
multiple spatial groups (usually with coincident or
overlapping geographic extents) are superimposed
and registered to each other in the View; these lay-
outs are useful in the design of electronic atlases.  A
tiled layout contains a tiled array of spatial groups
in the View.

For more
information about
layouts, see the
Displaying
Geospatial Data
and Making Map
Layouts tutorials.
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3D Perspective Views
STEPS

close the HYDROLAYOUT

layout
press the Open
Display icon
button
in the Select window,
navigate out of the
LAYOUTS Project File and
out of the PARKWAY folder
navigate into the VIEW3D
folder, then into the
view3D Project File
select GROUP3D and
press [OK]

Terrain surface layer
with elevation raster

Color-composite
satellite image drape

Vector drape layer

3D Perspective
View

Heading and
pitch controls

Distance slider

The Display process also allows you to create and
save groups that include both regular 2D views and
3D perspective views of the data.  A 3D group in-
cludes a terrain or surface layer that contains a raster
object whose cell values are used as elevation val-
ues to define a 3D surface.  Other layers containing
image or geometric objects are then draped over this
surface in the 3D perspective view.  The perspective
view provides controls to let you set the direction of
view and the distance between the viewpoint and
the data.  You can find more information about 3D
groups in the 3D Perspective Visualization tutorial.

2D View

What Next?  Your next step in learning about the Display process in the
TNTgis software products should be the tutorial booklet Displaying
Geospatial Data, which provides more detailed information about displaying
different types of geospatial data.
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MicroImages, Inc. publishes a complete line of professional software for advanced geospatial
data visualization, analysis, and publishing.  Contact us or visit our web site for detailed
product information.

TNTmips Pro TNTmips Pro is a professional system for fully integrated GIS, image
analysis, CAD, TIN, desktop cartography, and geospatial database management.

TNTmips Basic TNTmips Basic is a low-cost version of TNTmips for small projects.

TNTmips Free TNTmips Free is a free version of TNTmips for students and profes-
sionals with small projects.  You can download TNTlite from MicroImages’ web site.

TNTedit TNTedit provides interactive tools to create, georeference, and edit vector, image,
CAD, TIN, and relational database project materials in a wide variety of formats.

TNTview TNTview has the same powerful display features as TNTmips and is perfect for
those who do not need the technical processing and preparation features of TNTmips.

TNTatlas TNTatlas lets you publish and distribute your spatial project materials on CD or
DVD at low cost.  TNTatlas CDs/DVDs can be used on any popular computing
platform.
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mark elements...................................14-17
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Rectangle tool (GeoToolbox)................19
region.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .18
Ruler tool (GeoToolbox)...................19
Select tool..........................................14
Show/Hide button................................5,11
sidebar (View)..............................4,7-11,23
single record view (database table).......16
sketch..........................................20,21
s n a p s h o t . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2 5
tabular view (database table)..........12,15,16
Transparency sidebar control....................8
view canvas...................................4,5
View Position tool..............................6
View window options........................23-24
Zoom Box tool..........................................6
Zoom sidebar control...............................7
zooming... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6,7
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